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The controls in the Camera Icon 

 

                                       Figure 8-15 

 

8.4.2  Accessing E-Maps of Multiple Hosts 

If you have created E-Maps for multiple hosts, you can monitor these E-Maps remotely through a Web 

browser. Up to 500 hosts can be accessed at a time.  

 

1. To start, click Login  on the Remote E-Map window. The Login window appears.  

 



 
E-Map Application 
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2. Select a host on the right panel and click Login. You are prompted for the required login info. 

 

                           Figure 8-16 

3. Click OK to return to the Remote E-Map window. Now you can select the corresponding E-Map for 

the new host for monitoring. 

 

8.4.3  Configuring the Remote E-Map  

Click Configure  on the Remote E-Map window. The Configure dialog box appears. 

  

Figure 8-17 
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[Download E-Map files] Download E-Map files from the local server to the client PC. This option can 

reduce network loading if you wish to view the E-Maps of multiple hosts. 

 Use local E-Map files: After downloading E-Map files to the client PC, you can select and use 

these E-Map files for connection.  

 

[Motion] / [I/O Input] 

 Alert Sound: Assign a .wav file to alert the operator when cameras or I/O devices are triggered.  

 Camera Blink, I/O Blink: When cameras or I/O devices are triggered, their icons on the E-Map 

flash.  

 E-Map Auto Popup: When cameras or I/O devices are triggered, the related map will pop up on 

the screen instantly when the Remote-E-Map window is minimized.  

 Show Event: Display the information of triggered events on the Host Information window.  

 I/O Trigger Camera: When input devices are triggered, the related camera views will pop up. To 

enable this function, you must map input devices to cameras on the GV-VMS first. See Popping up 

Live View in Chapter 1. 

 Hide Tree List: Select to hide the tree list. 

 Enable DirectDraw: Enabled by default to speed up graphics rendering. Some graphics cards 

might not support DirectDraw and can produce distorted frames. In this case, disable the function. 

 Use Small Icon: Enable for devices to be displayed by smaller icons.  

 Retry in the Background: When the Remote E-Map is disconnected from GV-VMS, a warning 

message will pop up every 30 seconds. Select to hide the message and retry the connection in the 

background. 

 Disable 3D emap: Disable the 3D e-map function. 

 Loop alert sound: When Alert Sound is enabled, the assigned .wav file will be played repeatedly 

until it is turned off by the operator. 
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8.4.4  Viewing Event List and Playing back Videos 

You can see a list of triggered events on the Host Information window and play back the desired 

video(s).   

1. Click Host Information  on the Remote E-Map window. The Host Information window 

appears. 

 

Figure 8-18 

2. For event playback, double-click any motion event on the left panel. The player appears. 

3. Optionally right-click the image to access the advance functions of the player. 

 

8.5  E-Map Server  
The E-Map Server is an independent program designed to create E-Maps for different hosts. With 

E-Map Server, you can monitor different sites on electronic maps through any computer accessible to 

the network. 

 

8.5.1  Installing E-Map Server  

You can install GV-E-Map Server from the GeoVision Website. 

http://www.geovision.com.tw/download/product/GV-VMS�
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8.5.2  The E-Map Server Window 

Go to Windows Start > Programs > eMapServer and click E-Map Server. This window appears.  

 

Figure 8-19 

 

No.  Name Description 

1 Start Service  Starts the E-Map Server.  

2 Stop Service  Stops the E-Map Server.  

3 New  Creates a new E-Map file.  

4 Rename  Renames the E-Map file.  

5 Delete  Deletes the E-Map file. 

6 Refresh  Refreshes the E-Map Server window.  

7 Accounts  Creates user accounts of the E-Map Server.  
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8.5.3  Setting up E-Map Server 

Before starting the E-Map Server, you must create E-Map files and user accounts. 

 

 To create E-Map, click New (No. 3, Figure 8-19). See Creating an E-Map earlier in this chapter. 

 To create a user account for the server, click Accounts (No. 7, Figure 8-19). 

 

8.5.4  Connecting to E-Map Server 

With E-Map Server, you can monitor different sites on electronic maps through any computer accessible 

to the network. 

 

1. Open the Web browser and type the IP address of the E-Map Server.  

2. Type the login info of the E-Map Server. You are prompted to select an E-Map (.emp) file. 

3. Click OK. The Remote E-Map window appears (Figure 8-16). 

4. Click Login  to log into the desired host. For details, see Accessing E-Maps of Multiple Hosts 

earlier in this chapter. 

 

Note: To log into GV-VMS, make sure the WebCam Server is enabled. See Remotely Accessing 

E-Map earlier in this chapter. 

 

 



  
278

 

Chapter 9 

Useful Utilities ............................................280 

9.1  Dynamic DNS ..................................................................................... 280 

9.1.1  Running Dynamic DNS.....................................................................................281 

9.1.2  Registering Domain Name with DDNS.......................................................281 

9.1.3  Starting Dynamic DNS.....................................................................................282 

9.2  Watermark Viewer ........................................................................... 283 

9.2.1  Activating Watermark Protection ...............................................................283 

9.2.2  Running Watermark Proof ..............................................................................283 

9.2.3  The Main Window..............................................................................................284 

9.3  Windows Lockup............................................................................... 285 

9.3.1  The GV-Desktop Screen..................................................................................285 

9.3.2  GV-Desktop Features .......................................................................................286 

9.3.3  Token File for Safe Mode ................................................................................288 

9.4  Authentication Server..................................................................... 289 

9.4.1  Installing the Server ........................................................................................289 

9.4.2  The Main Window..............................................................................................290 

9.4.3  Creating Clients.................................................................................................291 

9.4.4  Creating User Accounts .................................................................................292 

9.4.5  Importing Groups and Users from Active Directory .............................295 

9.4.6  Starting Authentication Server ....................................................................298 

9.4.7  Connecting to Authentication Server ........................................................300 

9.4.8  Remote Access from Other Video Management Software / Mobile 

Application .......................................................................................................................302 

9.5  Fast Backup and Restore............................................................... 305 

9.5.1  Running the FBR Program..............................................................................305 

9.5.2  Plugin Component.............................................................................................306 

9.5.3  Customizing the Features ..............................................................................307 

9.5.4  Backing up and Restoring Settings ............................................................308 

9.6  Bandwidth Control ........................................................................... 311 

9.6.1  Installing the Bandwidth Control ................................................................ 311 

9.6.2  The Main Window..............................................................................................312 

9.6.3  Allowing Remote Control ...............................................................................313 

9.6.4  Connecting to WebCam Server ....................................................................314 



 
279

9.6.5  Controlling a Specific WebCam Server .....................................................315 

9.6.6  Setting up Bandwidth ......................................................................................316 

9.6.7  Setting up Block Lists .....................................................................................317 

9.6.8  General Setup ....................................................................................................318 

9.7  Language Setting ............................................................................. 319 

9.7.1  Installing the MultiLang Tool ........................................................................319 

9.7.2  Revising the Translated Text ........................................................................320 

9.7.3  Setting the UI Language to English............................................................323 

9.8  GV-SD Card Sync Utility ................................................................. 324 

9.8.1  Installing the Utility .........................................................................................324 

9.8.2  Setting up the Utility .......................................................................................325 

9.8.3  The Main Window..............................................................................................328 

9.9  Media Man Tools ............................................................................... 329 

9.9.1  The Media Man Tools Window ......................................................................329 

9.9.2  Viewing Disk Drive Status .............................................................................330 

9.9.3  Adding a Disk Drive ..........................................................................................332 

9.9.4  Removing a Disk Drive ....................................................................................333 

9.9.5  Logging in Automatically at Startup ..........................................................334 

9.9.6  Setting up LED Panel .......................................................................................334 

9.10  Alert Notifications through SNMP Protocol .......................... 337 

9.11  Local and Remote Backup .......................................................... 338 

9.11.1  Remote Backup ...............................................................................................338 

9.11.2  Local Backup ...................................................................................................338 

9.11.3  Advanced Settings .........................................................................................340 

9.11.3.1  Advanced Settings for Local Backup...................................................340 

9.11.3.2  File Transfer Settings for Local Backup .............................................341 

9.12  Report Generator ........................................................................... 343 

9.13  GV-Cloud Center ............................................................................. 343 



 
280

Useful Utilities 
GV-VMS supports some advanced utilities to enhance the system performance in a security network.  

 

9.1  Dynamic DNS  
GV-Dynamic DNS provides domain name registration, making your dynamic IP address point to your 

GV-VMS server. GV-Dynamic DNS will update the server’s IP address to DNS Server every 10 

minutes. Even if your server’s IP address changes, you can still locate it by using the registered 

domain name.  

 

Note: GV-Dynamic DNS uploads IP addresses over the Internet through ports 80 and 81. If your 

GV-VMS server is connected behind a router or firewall, make sure ports 80 and 81 are enabled. 

GV-Dynamic DNS will only upload global IP addresses. If your GV-VMS server is using virtual IP, NAT 

port mapping should be done first.  

 

IMPORTANT: The DDNS service simplifies the process of trying to connecting an IP video device to 

the network. However, GeoVision does not and cannot warrant that the DDNS service will be 

uninterrupted or error free. Please read Terms of Service carefully before using the service. Besides 

GeoVision, you can also obtain the free DDNS service from these providers: DynDNS.org and 

No-IP.com. 

 

CHAPTER        

9   

http://www.dyndns.com/�
http://www.no-ip.com/�
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9.1.1  Running Dynamic DNS  

GV-Dynamic DNS Service is included in the installation of GV-VMS. Go to Windows Start > 

Programs > GV-VMS > DNS Client V2. The DNSClient V2 dialog box appears.   

 

9.1.2  Registering Domain Name with DDNS 

1. Click Register on the DNSClient V2 dialog box. The registration page appears. 

 
Figure 9-1 

2. Type a username and password and the Word Verification code. The password must be at least 6 

characters.  

3. Click the Send button. The following message appears.  

 

                                Figure 9-2  

 Hostname: Made by registered username and “gvdip.com”. In this example, the hostname is 

“http://julia.gvdip.com”. This will be the domain name used to log into your system.  

 IP Address: Your system’s current IP address. This IP address is updated every 10 minutes.  

 

Note: The domain name .gvdip(xx).com may vary with xx from 01 to 99.  
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9.1.3  Starting Dynamic DNS 

After registering a domain name with GV-Dynamic DNS, enable the DDNS function on your system. 

Run DDNS Client V2 (Figure 9-1) and be sure GeoVision software is also enabled at the background.  

 

After typing the Hostname and Password used to enable the Dynamic DNS service, complete the 

following settings: 

 Obtain an IP address automatically: The DDNS Server will use any available IP address from 

the system or the router. 

 Use the following IP address: If your system or router has more than one IP address, you can 

assign one IP address to connect between the DDNS Server and the GV-VMS system. It is 

highly suggested to assign a fixed IP address instead of a dynamic IP address, which will not be 

accessible for the DDNS when the IP address is changed. 

 Run at startup: Select to automatically run the DDNS service at Windows startup.  

 E-mail Setting: 

o Scheme: Select a given situation to receive e-mail notifications. 

o Sender: Type the name, e-mail address, username and password of the sender. 

o Receiver: Type the recipient’s e-mail address(es). For multiple recipients, add a semicolon   

between each e-mail address. 

o Mail Server: Type the host name or address of your mail server. Keep the default port 25 or 

modify if the mail server uses a different port. Select SSL if your e-mail server requires the 

SSL authentication for connection. 

o Click the Test button to send a test e-mail to confirm if the settings are correct. 

 

Click Save. The connection information will be displayed.  

 

Note: The DNS Client will not upload the IP address unless the compatible GeoVision software is 

running such as GV-VMS in the background. If the IP address of your system is not updated for more 

than 30 days, your host name will be deleted automatically. 
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9.2  Watermark Viewer 
GV-VMS can embed digital watermarks in video streams for authentication purposes. The watermarks 

are encrypted with digital signatures in video streams during the compression stage, ensuring that 

images are not edited or damaged after they are recorded. In addition, you can apply the Watermark 

Proof, a watermark-checking program included in the installation of GV-VMS, to further verify the 

authenticity of the recording.  

 
 

9.2.1  Activating Watermark Protection 

To enable the watermark protection, click Home  > Toolbar  > Configure  > System 

Configure > Record Setting, and select Use Digital Watermark Protection. GV-VMS will digitally 

sign videos during the recording.  

 

                                     Figure 9-3  

 

9.2.2  Running Watermark Proof 

1. Locate the GV-VMS folder and run WMProof.exe. The Watermark Proof window appears. 

2. Click File from the menu bar, select Open, locate the recorded file (.avi) and click Open. The 

selected file is listed on File List (No. 9, Figure 9-4). Alternatively, you can directly drag the file 

from the storage folder to the window. 

˙ If the recording is unmodified, a check mark will appear in the Pass column.  

˙ If the recording is modified or does not contain watermark during recording, a check mark will 

appear in the Failed column. 

3. To play the recording, double-click the listed file on the window. 
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9.2.3  The Main Window 

 

                        Figure 9-4 

 

No. Name Description 

1 Open File Opens the recorded file.  

2 First Frame Goes to the first frame of the file. 

3 Play Plays the file. 

4 Previous Frame Goes to the previous frame of the file. 

5 Next Frame Goes to the next frame of the file. 

6 Previous Watermark Frame Goes to the previous frame that contains watermark. 

7 Next Watermark Frame Goes to the next frame that contains watermark.  

8 Original vs. Extracted 
The Extracted icon should be identical with the Original 
icon. If not, it indicates the recording has been tampered.

9 File List  Displays the proof results.  

 

 



 
Useful Utilities 

 
 

 
285

9 

9.3  Windows Lockup 
GV-Desktop helps you secure your computer while away from your workstation. You may lock up the 

Windows desktop while launching a customized GV-Desktop. In GV-Desktop, users are limited to run 

GV-VMS and only selected programs. 

 

9.3.1  The GV-Desktop Screen 

GV-Desktop is included in the installation of GV-VMS. Go to Windows Start > Programs > GV-VMS > 

Key Lock Utility. The GV-Desktop screen appears.   

 

                                         Figure 9-5 

 

No.  Name Description 

1 Programs Accesses programs. 

2 Settings Adds programs to the programs menu. 

3 Log Off Logs off GV-Desktop. 

4 Shut Down Shuts down the computer. 

5 Task Manager Views the tasks currently running on your computer. 
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9.3.2  GV-Desktop Features 

 

Programs 

Click the Programs button (No.1, Figure 9-5) to see the program menu. The default programs are 

Video Management System (GV-VMS), Repair Database Utility, eMap Editor and Control Center 

Service. To add or remove new programs to the menu, see the Settings section later in this chapter. In 

the example below, Paint is a new program added to the menu. 

 

               Figure 9-6 

 

Settings 
Click the Settings button (No.2, Figure 9-5) and type the valid ID and password. This window appears.  

 

          Figure 9-7 
 

[Password] Change the password. For Allow Removing Password System, see Account and 

Password in Chapter 1. 
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[Export Token] See Token File for Save Mode later in this chapter.  

[System Menu] Select a desired program and click the Edit button to change its name. 

[Customize Menu] Set up the Programs menu as desired. To add a program, click the Add button. In 

the Shortcut dialog box, type the program name, click the button next to the field to assign a path and 

click OK. 

[Administrative Tools] Set up the Programs menu as instructed in Customized Menu option. To run 

the added programs configured in the Administrative Tools field, the administrative ID and Password 

are required. 

[Desktop Type] Select Windows or GV-VMS from the drop-down menu. The selected desktop will 

launch the next time when you log into the computer.  

 

Log Off 

Click the Log off button (No.3, Figure 9-5) to log off GV-Desktop with a valid ID and password. 

 

Shut Down 

Click the Shut Down button (No. 4, Figure 9-5) to shut down your computer with a valid ID and 

password. 

 

Task Manager 

Click the Task Manager button (No. 5, Figure 9-5) to view the programs which are currently running on 

your computer. When you minimize a program, it will be hidden and under operation in the background. 

To bring the program back to desktop, double-click the program listed in Task Manager. 

 

Figure 9-8 
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9.3.3  Token File for Safe Mode  
This option in the Settings section lets you export a token file. In case you start Windows in Safe Mode 

and in the status of GV-Desktop, this token file allows you to exit from GV-Desktop and enter Windows 

desktop. To export a token file, follow the steps below. 

 

Exporting the Token File 

1. Click the Export Token button (Figure 9-7). The Enter Token Code appears. 

2. Type a code in the Token Code field and click OK.  

3. In the Save As dialog box, locate a path, type a desired name in the File Name field and click 

Save to save the file. 

 

Switching from GV-Desktop to Windows Desktop 

1. Click the Settings button on GV-Desktop. You will be prompted to locate the stored token file and 

type the configured token code. 

2. When the Settings window (Figure 9-7) appears, select Windows in the Desktop Type field and 

exit from the window.  

3. Click the Log Off button to log off GV-Desktop and run the Windows desktop. You need to locate 

the stored token file and type the configured token code again. 
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9.4  Authentication Server 
GV-Authentication Server is a password and account management system for multiple GV-VMS 

systems. Through the Authentication Server, the administrator can create the accounts with different 

access rights to a group of GV-VMS systems. Once any GV-VMS is connected to the Authentication 

Server, the previous password settings in local GV-VMS will be invalid. Local GV-VMS will submit to 

the full control of the Authentication Server. 

 

Note:  

1. In addition to GV-VMS / DVR / NVR where the Authentication Server acts as a password and 

account management system, the Authentication Server also supports E-Map Server, 

GV-Control Center, GV-Edge Recording Manager and GV-Eye app to allow users to access a 

specified group of GV-VMS / DVR / NVR hosts through an Authentication user account. 

2. GV-Eye V2.8.0 or later and GV-Edge Recording Manager V2.1.0 or later support multiple 

GV-Authentication Server connections at a time. 

 

9.4.1  Installing the Server 

You can install GV-Authentication Server from Utility in GeoVision Website. 

 

http://www.geovision.com.tw/download/product/GV-VMS�


 
 
 

  
290

9.4.2  The Main Window 

Go to Windows Start > Programs > AuthServer > AuthServer. This window appears. 

1 2 3 4 5 6 7 8 9 10

11

12

13

 

           Figure 9-9 

No. Button  Description 

1 Add An Area Creates an Area group. 

2 Add A Client Creates a client account. 

3 Delete An Area / Client Deletes an existing group or client. 

4 View / Edit A Client Select a client from the Client List, and click to view / edit it. 

5 Find A Client Finds an existing client.  

6 Start / Stop Service Starts / Stops the Authentication Server. 

7 Server Setup Configures the Authentication Server. 

8 Account Setup 
Configures passwords and grants permissions to clients. Imports 

groups from Active Directory. 

9 Log  Sets up the Authentication Server Log and opens the log browser. 

10 Exit 
Exits this window; Logs out Administrator; Changes  

Password, imports or exports account information.  

11  Connected Client List 
Lists the connected clients: GV-VMS / DVR / NVR, E-Map Server, 

GV-Control Center, GV-Edge Recording Manager and GV-Eye. 

12  Client Information Lists the information of the selected client. 

13 Client List Lists the created clients.  
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9.4.3  Creating Clients 

You must create and arrange the clients first which user credentials will be centrally managed by the 

Authentication Server. To create a list of GV-VMS clients, follow the steps below.  

 

1. To create a GV-VMS client, highlight the Host List from the left pane and click the Add A Client 

button . The Client Information dialog box appears. 

 

   Figure 9-10 

2. Type the client’s information and select Automatic get connection info. The Name must match 

that of local GV-VMS. 

3. Optionally select Manual Setting and type the IP address of the Authentication Server. Keep the 

default ports or modify them if necessary. 

 

Figure 9-11 

4. Click OK. 
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Tip: To view the name of your GV-VMS system, select Toolbar  > Configure > System 

Configure > General Setting.  

 

                     Figure 9-12 

 

5. To create another client, repeat the steps above.  

6. You can also arrange multiple clients under a group by highlighting a list and clicking the Add An 

Area button (No. 1, Figure 9-9). The created group appears under the selected List. 

 

9.4.4  Creating User Accounts 

To create user accounts with different access rights and assign the user accounts to a group of 

GV-VMS clients, follow the steps below.  

 

1. Click the Account Setup button (No.8, Figure 9-9) > Password Setup. The Password Setup 

dialog box appears.  

2. Create a user account. Refer to Account and Password in Chapter 1. 

 

Note: The Administrator has the authority of changing the passwords of any accounts. 
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3. To assign the created user to a group of GV-VMS clients:  

A. Click the Group Setting button.  

 

Figure 9-13 

B. In the Valid Group List window, click the New Group button.  

    

Figure 9-14 

C. In the DVR Group Information window, name the group, select the GV-VMS clients to be 

added to the group. Click OK. 

 

Figure 9-15 

D. Click OK again to return to the Password Setup window.  
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E. Use the Valid Group drop-down list to select the created group. The user will be able to log in 

the assigned GV-VMS clients. 

 

Figure 9-16 

4.  Optionally use the following functions to arrange the user and client accounts. 

A. Right-click a user account to have two options. The Apply setting to option will apply the 

same settings to a specific user account. The Apply setting to group option will apply the 

same settings to all user accounts under the same account level.  

 

Figure 9-17 

B. Right-click a client account to have two options. The Apply setting to other DVR(s) option 

allows you to apply the same settings to all clients under the same user account. For this 

example, the settings of Building A client will be applied to all Building B, C and D clients. The 

Copy option allows you to copy and paste one client’s settings and any client. 

    

Figure 9-18 
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9.4.5  Importing Groups and Users from Active Directory 

To create user accounts efficiently, you can import groups and users from Microsoft’s Active Directory 

to the Authentication Server. You will need to install Active Directory on Windows Server and set up 

users into groups before following the steps below. 

 

Note: User accounts in Active Directory need to be grouped into Groups settings first as only groups 

can be imported into Authentication Server. 

 

1. Run Active Directory Domains and Trusts in Windows Server by clicking the Start menu and 

opening Administrative Tools. 

2. Right-click your local Active Directory system and select Manage. The Active Directive Users and 

Computers dialog box appears. 

 

 

Figure 9-19  
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3. On the View menu, select Advanced Features. 

 

Note: If you use Windows Server 2008 instead of Server 2012, skip Step 3. 

 

4. Right-click the folder saved with the user accounts or groups and select Properties. 

 

Tip: You can change the query parameters or show all items for each folder by clicking View and 

selecting Filter Options. 

 

5. Select the Attribute Editor tab, double-click the attribute distinguishedName and copy the value 

like OU=persons,DC=FAE,DC=com. You will need to paste the value at step 8, C to assign the 

folder to import the user accounts or groups. 

6. In the Authentication Server, click the Account Setup button (No.8, Figure 9-9) and select Active 

Directory Setup. This page appears. 

 

Figure 9-20  

7. Under Source Database, select Active Directory to enable the function. 
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8. To connect to the server with Active Directory: 

A. Type the Server IP Address and the Port number of the server. 

B. To log into the server using your current login credentials, select Connect with the current 

login information. To log into the server using the login credentials of its administrator, select 

Connect with administrator login information. 

C. Paste the value of distinguished name you copied at step 5 respectively to Group / Users 

Search Base. 

D. Click Test Connection to see if you can connect to the server with Active Directory. 

9. To assign groups in Active Directory to User, Power User or Supervisor authority levels: 

A. Click the Assign Authority Level button. This dialog box appears. 

 

Figure 9-21 

B. Select the groups detected in Active Directory from the Undefined Group list and use the 

arrow buttons  to assign the groups to User, Power User or Supervisor level.  

C. Click OK to import the user data into the Password Setup window. 

10. To automatically update changes to user data in Active Directory, click Auto Update and specify 

the update frequency in minutes. 

11. Click OK and restart the Authentication Server to apply the settings. 
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9.4.6  Starting Authentication Server  

To configure and start the Authentication Server, follow the steps below. 

 

1. Click the Server Setup button (No. 7, Figure 9-9). This dialog box appears. 

 

     Figure 9-22  

2. Under Security Setting, type the Authorized ID and Authorized Password which will be used for 

the GV-VMS client to log into the Authentication Server. 

3. Click OK to apply the settings. 

4. Click the Start/Stop Service button (No. 6, Figure 9-9) to start the services.  

 

Optionally, you can configure the following settings before starting the Authentication Server:  

[Network Setting]  

 Server Port: The default port number is 3663. To use UPnP for automatic port configuration to 

your router, click the Arrow button. For details, see UPnP Settings in Chapter 7. 

 Automatic Failover Support: Select and click the Setting button to configure up to 2 

Authentication Servers in case the primary Authentication Server fails. If fails, the second or the 

third server will take over the connection from clients and provide uninterrupted services. Note the 

settings of Authorized ID and Authorized Password on the failover server must match those of the 

primary server. 
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Tip: To set up the failover Authentication Server, you can export the current settings by using the 

Export Account and Import Account functions in the Exit button. 

Note: Once the primary Authentication Server is ready to resume the services, close the failover 

Authentication Server so the connection from clients can move back to the primary. 

 

[Security Setting] 

 Enhance network security: Strengthen network security on the Authentication Server. 

 Enable IP White List: Click Edit to create a list of IP addresses only which are allowed to 

establish connection with the Authentication Server.   

 

[Server Setting] 

 Auto run server service upon startup: Starts the service automatically upon the startup of 

Authentication Server. 

 Notify when DVR is disconnected from server: Notify the Authentication Server with a pop-up 

window when GV-VMS is disconnected with the Authentication Server. 
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9.4.7  Connecting to Authentication Server 

To configure GV-VMS in order to access the Authentication Server remotely through a network 

connection, follow the steps below. 

 

1. On the main screen of GV-VMS, click User  > Password Setup > Remote Authentication 

Setup. The Setup Remote Authentication Server dialog box appears. 

  

                   Figure 9-23 

 

2. Select Use Remote Authentication and optionally select: 

[When Remote Authentication Server Off-line] 

 Allow local supervisor to stop using Remote Authentication System: Allow the local 

supervisor to stop the Authentication application when the connection fails with the 

Authentication Server. Note if the option is disabled and the connection fails with the 

Authentication Server, the local supervisor will not be able to log into GV-VMS, and the dialog 

box will not be accessible until the connection resumes. 

 Allow user to use local account login remote application: Allow local users to access 

remote applications with their previous password and ID settings when the connection with the 

Authentication Server fails.  

 Login with authentication server backup account: Keep using password settings created 

on the Authentication Server even though the connection with the server fails. 

3. Click Setup Server. The Remote Authentication dialog box appears.  

4. Type the IP address and port of the Authentication Server.  

5. Type the Authorized ID and Authorized Password of the Authentication Server.  

6. Click OK to start the connection. When the connection is established, the previous password 

settings in GV-VMS will be invalid. 
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7. Press [L] on the keyboard to call up the Login dialog box. The icon  indicates that the 

connection is established. 

  

                Figure 9-24 

As long as the Authentication Sever works, the Login dialog box will appear upon the starting of 

GV-VMS. Type the user account created on the Authentication Server to log into GV-VMS.  

 

Note: The disconnection icon  will appear on the Login dialog box (Figure 9-24) when one of the 

following situations occurs: 

1. The login ID and Password do not match any of the user IDs and Passwords created on the 

Authentication Server. 

2. The client name does not match the location name of GV-VMS (Figure 9-12). 

3. The network connection encounters traffic problems. 
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9.4.8  Remote Access from Other Video Management 

Software / Mobile Application 

The Authentication Server supports E-Map Server, GV-Control Center, GV-Edge Recording Manager, 

and GV-Eye to allow users to access a specified group of GV-VMS hosts through an Authentication 

user account.  

 

You must first set up remote authentication on E-Map Server, GV-Control Center, GV-Edge Recording 

Manager, or GV-Eye. After the they are connected to the Authentication Server, the user will be 

prompted to log in with the user ID and password you created on the Authentication Server. Once the 

user logs in, a list of GV-VMS hosts authorized to the user account will be displayed, and the user will 

be able to view the assigned cameras.  

 

 

Setting up Authentication Server 

You need to create and arrange client accounts of E-Map Server, GV-Control Center, GV-Edge 

Recording Manager, or GV-Eye under their separate lists on the Authentication Server window (Figure 

9-9).  

 

1. In the Client List field, click the E-Map Server List or Client List, and click the Add A Client 

button (No. 2, Figure 9-9). The Client Information dialog box appears.  

2. Type the name and information of the desired software or mobile app to be connected. The name 

does not need to match the location name of the software or mobile app. 

3. Click OK to add the client. 

 

 

Accessing from E-Map Server  

The E-Map Server can access the account setting of the Authentication Server.  

 

1. Run the E-Map Server. For details, see E-Map Sever in Chapter 8. 
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2. In the E-Map Server window, click Tools on the menu bar, and select Options. This dialog box 

appears.  

 

    Figure 9-25 

3. Select Use Remote Authentication.  

4. To enable the Authentication Server service to start automatically at Windows startup, select 

Automatic. Keep the E-Map Server Port 80 as default or modify if necessary.  

5. Click OK to apply the settings. 

 

6. In the E-Map Server window, click Tools on the menu bar and select Remote Authentication. 

This dialog box appears.  

 

           Figure 9-26  

7. Type the IP address, authorized ID and authorized password of the Authentication Server, as well 

as the E-Map Server’s client name created on the Authentication Server, and then click OK. 

8. In the E-Map Server window, click Tools on the menu bar and select Start Service to start the 

E-Map Server.  

9. When you log into the E-Map Server, type the user ID and password created on the Authentication 

Server. A list of assigned GV-VMS clients to the user will be displayed. 
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Accessing from GV-Control Center 

GV-Control Center can access account settings of the Authentication Server.  

 

Note: The Authentication Server only supports GV-Control Center V3.1.2.0 or earlier. 

 

1. Run GV-Control Center.  

2. On the Host List, right-click Host List by ID and select Remote Authentication Setup. A dialog 

box appears. 

3. Type the IP address, authorized ID and authorized password of the Authentication Server, as well 

as Control Center’s client name created on the Authentication Server, and then click OK to enable 

connecting to the Authentication Server.  

4. To access the Authentication Server account settings, on the Host List, right-click Host List by ID 

and select Get Host List by ID. A dialog box prompts you for ID and password.  

5. Type a user ID and password created on the Authentication Server, and click OK. A list of 

assigned GV-VMS hosts to the user will be displayed.  

 

For details, see GV-Control Center User’s Manual 

 

 

Accessing from GV-Edge Recording Manager / GV-Eye 

For details, see Chapter 8 in GV-Edge Recording Manager User’s Manual or Chapter 13 in GV-Eye 

Installation Guide. 

 

https://s3.amazonaws.com/geovision_downloads/Manual/Control-Center/EN/GV-Control_Center_User_Manual.pdf�
https://s3.amazonaws.com/geovision_downloads/Manual/Edge-Recording-Manager/GV-Edge_Recording_Manager_User_Manual.pdf�
https://s3.amazonaws.com/geovision_downloads/Manual/GV-Eye/GV-Eye-Installation-Guide.pdf�
https://s3.amazonaws.com/geovision_downloads/Manual/GV-Eye/GV-Eye-Installation-Guide.pdf�
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9.5  Fast Backup and Restore  

With the Fast Backup and Restore (FBR) solution, you can change interface skin and customize 

features to suit personal preference, as well as backing up and restoring your configurations in 

GV-VMS.  

 

9.5.1  Running the FBR Program  

Go to Windows Start > Programs > GV-VMS > Fast Backup & Restore Main System. You will be 

prompted to enter a valid ID and Password of GV-VMS, and then this window will appear.  

 

                              Figure 9-27 



 
 
 

  
306

9.5.2  Plugin Component 

You can add programs to your GV-VMS to expand the applications.  

 

1. In the FBR window (Figure 9-27), click the Plugin Component icon. This dialog box appears.  

 

                    Figure 9-28 

2. Click Add. The Add New Item dialog box appears.  

 

Note: For some applications, type /FBR in the Parameter column if necessary. 

 

3. Type the name of the desired application, locate its path and click OK. 

4. To add more applications, repeat steps 1 to 3 and click OK in the User Define dialog box. 

5. To access the added applications, run GV-VMS, click Home  > Toolbar  > Tools  > 

Plugin and select a desired application. 
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9.5.3  Customizing the Features  

Not every feature may be of equal interest to you. You can specify which features are to be displayed 

at system startup.   

 

1. In the FBR Window (Figure 9-27), click Customize Features. This dialog box appears.  

 

Figure 9-29  

2. Expand the folder and click the function you want to disable in GV-VMS. 

3. Click OK to save the settings.  

4. Restart GV-VMS for the settings to take effect. 
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9.5.4  Backing up and Restoring Settings 

You can back up the configurations you made in GV-VMS, and restore the backup data to the current 

system or import it to another GV-VMS. 

 

Backing up the settings 

1. In the FBR window (Figure 9-27), click Backup GV-VMS Settings or Restore Defaults > 

Backup Current System.  

2. Select which settings you want to back up and click the Next Step button .  

3. In the Save As dialog box, select the destination to store the backup file. When the backup is 

complete, the “Successfully Backup GV-VMS System Settings” message will appear: 

 

Restoring the System 

You can restore the current system with the backup of configuration file. Also, you can copy this 

backup file to configure another system with the same settings as the current system.  

 

1. Open the backup file (*.exe) you previously stored.  

 

Figure 9-30 

2. Click Restore GV-VMS System and select which backup settings you want to restore.  

3. Click the Next Step button  to start restoring.  

4. When the restoration is complete, the “Successfully Restore GV-VMS System Settings” message 

will appear. 
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Scheduling Configuration Backup 

You can now set up a regular schedule with password protection to back up the GV-VMS 

configurations you made.  

 

1. Go to Windows Start > Programs > GV-VMS > Fast Backup & Restore Main System.  

2. Click Backup GV-VMS Settings or Restore Defaults > Schedule Setup. 

3. Select Active Schedule.   

 

Figure 9-31 

4. Select a desired schedule type.  

5. Select desired options for backup.  

 Password: Back up all the user accounts and password settings of GV-VMS. 

 General: Back up all the settings of video analysis, IP devices, system configurations, 

Content List, E-Map, GV-Keyboard / GV-Joystick, and System Log. 

 Schedule: Back up the recording schedule configuration. 
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 Network: Back up the network configuration of connection to VSM (Vital Sign Monitor) and 

to Center V2. 

6. Type a user ID and password in the Login Information section. The ID and password must be 

identical with that of a user account created in GV-VMS. You will need to use this ID and password 

to restore the backup file. 

7. Locate a path to save the backup contents. 

 

Restoring Defaults 

To restore the system default, click the Backup GV-VMS Settings or Restore Defaults icon (Figure 

9-27), select Restore Defaults and follow the on-screen instructions to complete the process.  
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9.6  Bandwidth Control 

The Bandwidth Control is an independent application that controls and monitors the network traffic of 

the WebCam Servers. It has the following features:   

 Manage up to 5 GV-VMS systems 

 Get bandwidth usages of every Webcam Server and every user 

 Set bandwidth thresholds for specific users and IP addresses 

 IP black and white list 

 Kick unwanted users 

 

9.6.1  Installing the Bandwidth Control 

You can install GV-Bandwidth Control Client Site from Utility in GeoVision Website. 
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9.6.2  The Main Window 

After the installation is complete, double-click the Bandwidth Remote Control icon created on the 

desktop. The Bandwidth Control window appears.  

 

1 43

8

52

67
 

Figure 9-32 
 

No.  Name Description 

1 Connection  Builds the connection to a WebCam Server.  

2 Disconnect  Stops the connection to a WebCam Server.  

3 Get Control  Obtains the right to remotely control a WebCam Server.  

4 Give Up Control  Ceases controlling WebCam Servers and users.  

5 User List  Displays the connected users and their status  

6 Bandwidth Record Displays the network traffic in graph display.  

7 Event Log  Records activities of WebCam Servers and users.  

8 Host List Displays all WebCam Servers to be connected.  
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9.6.3  Allowing Remote Control  

To allow the remote bandwidth control to the WebCam Server, follow the steps below.  

 

1. On the main screen of GV-VMS, click Home  > Toolbar  > Configure  > Network 

 > WebCam Server. This dialog box appears. 

 

Figure 9-33 

2. Under the General tab, select Run Bandwidth Control server. After this option is enabled, on 

the Control Center Server option list, the Bandwidth Control Service is marked with a check.  

 

Figure 9-34 
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9.6.4  Connecting to WebCam Server  

1. Click the Connection button (No. 1, Figure 9-32) on the toolbar. This dialog box appears.  

 

  Figure 9-35 

2. To add a WebCam Server to be connected to, click Add.  

3. Type the host name, IP address, user name and password of the WebCam Server. Modify the 

port if necessary. 

4. Click OK. After the connection is established, the WebCam Server shows up in the Host List.  

5. You can add up to 10 WebCam Servers by repeating above steps. 

6. To stop the connection, select the host and click the Disconnect button (No. 2, Figure 9-32). The 

host will be deleted from the host list. 

7. Up to 5 users of the Bandwidth Control programs can connect to a single WebCam server for 

network traffic monitoring. However, only one user has the access to bandwidth settings. When 

this user clicks the Give Up Control button (No. 4, Figure 9-32), the user no longer controls the 

WebCam Server. Whoever clicks the Get Control button (No. 3, Figure 9-32) first has access to 

bandwidth settings. For bandwidth settings, see Controlling a Specific WebCam Server later in 

this chapter. 
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9.6.5  Controlling a Specific WebCam Server 

To disconnect a login user or set the bandwidth limit for a specific user, right-click the user to have the 

options below: 

 

 

                                 Figure 9-36 

 

 Kick: Disconnect the user from the WebCam Server.  

 Block IP: Prohibit the user from connecting to the WebCam Server. To use the function, the 

Enable IP Black List option (Figure 9-39) must be selected first. 

 Bandwidth Setup: Select By Username to specify a bandwidth limit for the user, or select By IP 

to limit the bandwidth used by the IP address. This setup dialog box will appear. In this example, 

an IP address is selected for bandwidth limit setup. Select Bandwidth Setup, specify a 

bandwidth limit and click OK.  

 

               Figure 9-37 
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9.6.6  Setting up Bandwidth 

You can manage the bandwidth of multiple hosts allocated to a WebCam Server by specifying certain 

users and IP addresses when your network is busy or heavily loaded.  

 

1. Click Configure on the menu bar and select Bandwidth Setup.  

2. In the Bandwidth Setup dialog box, select the desired WebCam Server and click OK. This dialog 

box appears.  

 

Figure 9-38 

 Bandwidth limit: Select to define the total bandwidth that the WebCam Server will be 

allowed to use on your network.  

 By IP: Click Add and specify an IP address or a range of IP addresses and its bandwidth 

limit.  

 By Username: Click Add and specify the user name and its bandwidth limit.  

 

Note: If you have already specified the total bandwidth to a WebCam Server, it is prioritized before 

the bandwidth limits set to user names and IP addresses. 
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9.6.7  Setting up Block Lists  

Two types of block lists are provided to restrict the access to a WebCam Server: permitting and 

denying a specified range of IP address to establish the connection. Note that only one type of block 

list can be used at a time.  

 

1. Click Configure on the menu bar and select IP White / Black List Setup. A dialog box prompts for 

you to select a host.  

2. In the IP White / Black List Setup dialog box, select the desired WebCam Server and click OK. 

This dialog box appears.  

 

Figure 9-39 

3. Select a desired type of block list and click Add to define the IP addresses. 

 Enable IP White list: Allow the defined range of IP addresses to establish the connection to 

the WebCam Server.  

 Enable IP Black list: Prohibit the defined range of IP addresses from establishing the 

connection to the WebCam Server.  

4. Click OK to apply the settings. 
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9.6.8  General Setup  

You can set up sound alarm for user log-in, or change the real-time graph display of network traffic. 

Click Configure on the menu bar and select General Setup. This dialog box appears.  

 

     Figure 9-40 

 Auto Connect: Enable the application to connect to previously connected hosts automatically 

next time the application restarts, 

 User Login Alarm: Enable the computer alarm on when a user logs in. 

 Bandwidth Display Option: Set the color of bandwidth save, grid lines of the graph and the 

background color of the graph. 

 Number of Grid Line: Set the number of grid lines to be displayed on the graph.  

 

You can click the Bandwidth Record tab in the Bandwidth Control window to view the network traffic in 

graph. 

 

Figure 9-41 
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9.7  Language Setting 

The user interface has been translated from English into 30 other languages. If you find the translation 

to be unsuitable and would like to correct it, use the MultiLang Tool to revise the translation. Next, you 

can apply the revised text to the applications and export a MRevise.exe file to make the same revision 

on another computer. You can also send the revision back to GeoVision to have the revision included 

in future software release. 

 

9.7.1  Installing the MultiLang Tool  

You can install GV-MultiLang Tool from Utility in GeoVision Website. 

 

http://www.geovision.com.tw/download/product/GV-VMS�
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9.7.2  Revising the Translated Text  

Revising the Translated Text 

1. After completing the installation, close all GeoVision applications, go to Windows Start > 

programs > MultilingualConfig. This dialog box appears. 

 

                       Figure 9-42 

2. Click Language and select the language of the text you want to revise.  

3. Click Version to select the version of GV-VMS that you want to revise. 

4. In the Search field, type all or part of the text in English or the target language and click Search. 

The results are displayed. 

 

Note: The search is case sensitive.  

 

5. Double-click the text you want to revise. This dialog box appears. 

 

Figure 9-43 
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6. Revise the translated text and click OK.  

 

Note:  

1. It is recommended to revise an entire sentence at a time instead of simply searching a single 

word and replacing the word in all other strings. 

2. The text may contain symbols such as %d or \n that instruct the application to perform certain 

functions. Be careful not to change the symbols in the translated text. 

3. Before making any revision, click Tools and select Revision Note to read the revision 

instructions. 

 

Applying the Revised Text 

1. To apply the revised translation to the applications, click Save. This dialog box appears. 

 

Figure 9-44 

Note: The system will automatically locate the corresponding files on your computer and replace with 

the revised translation for the following applications: GV-VMS, Authentication Server, Bandwidth 

Control Client Site, Center V2, Dispatch Server, Fast Backup and Restore (FBR), GV-IP Device 

Utility, MCamCtrl Utility, Remote E-Map and Remote ViewLog. 

 

2. Click OK. The message “Do you want to apply the revised multilingual texts to another folder?” 

appears. If the storage path for the application has been changed or if the associated application 

is not listed in the dialog box, click Yes and select the folder of the application.  
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Exporting the Revised Text 

1. To export the revision as an executable file, click Tools > Export > Export executable file. You 

can copy the .exe file to another computer and apply the same translation revision by running 

the .exe file. 

2. To report the translation revision back to GeoVision: 

 If your default mail client is Outlook, Outlook Express or Mozilla Thunderbird, click Tools, 

Export and Send Report to send the revision. 

 If your default mail client is not set up or supported, click Tools, Export and Export text file, 

and email the exported text file to gvlocalize@geovision.com.tw. 

3. For the distributors to duplicate Software DVD with the translation revision, 

 Copy and paste all the contents of Software DVD to your computer. 

 Export the revised translation file and rename the file as MRevise.exe.  

 Move MRevise.exe to the location you saved the contents of Software 

DVD :\Software\Translation Revision.  

 Duplicate the Software DVD with the MRevise.exe file.  

 Test the Software DVD by clicking 10. Import Translation Revision from the Install Program 

window to apply the translation revision. 

 

mailto:gvlocalize@geovision.com.tw�
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9.7.3  Setting the UI Language to English  

The default user interface (UI) language of the following GeoVision software and applications is set 

according to the region detected. You can install the Set Language tool to set the UI language to 

English.  

 GV-AI Guard 

 GV-VMS 

 GV-Fast Backup and Restore Multicam System 

 ViewLog 

 GV-Remote ViewLog 

 GV-IP Device Utility 

 GV-Center V2 

 GV-Dispatch Server 

 GV-Control Center 

 GV-Remote E-Map 

 

You can install GV-Set Language tool from Utility in GeoVision Website. 

 

1. In the Configure window, select English from the Language drop-down list. 

 

                  Figure 9-45 

2. Click OK and restart your GeoVision software or application to enable the English UI. 

http://www.geovision.com.tw/download/product/GV-VMS�
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9.8  GV-SD Card Sync Utility 

GV-SD Card Sync Utility allows you to download videos from the memory card inserted in GV-IP 

Camera. When the connection between GV-IP Camera and GV-VMS is lost, recordings are 

automatically saved to the memory cards inserted in GV-IP Camera. To automatically synchronize and 

download recordings from the memory card to a local folder, install and execute the program on the 

GV-VMS.  

 

Note:  

1. GV-SD Sync Card Utility is only supported by GV-IP Cam H.264 V1.11 or later, GV-IP Cam 

H.265 V1.00 or later, GV-BX2600 V1.00 or later, GV-PPTZ7300 V1.01 or later, and GV-SD2411 

/ BX12201 / FER12203 V1.01 or later. 

2. It is recommended to keep GV-SD Card Sync Utility running in the background to automatically 

synchronize and download videos. 

3. Besides the syncing SD card using GV-SD Card Sync Utility, GV-VMS also supports the Sync 

recording from camera SD card when reconnected function; see 1.3.2 Setting up Recording 

Settings for Individual Cameras. 

 

9.8.1  Installing the Utility 

You can install GV-SD Card Sync Utility from Utility in GeoVision Website. 

 

 

http://www.geovision.com.tw/download/product/GV-VMS�
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9.8.2  Setting up the Utility 

1. Run GV-SD Card Sync Utility. The main window and the Setting window appear. The Setting 

window pops up automatically upon first execution. Otherwise, click the Setting button  on the 

main window. 

 

                    Figure 9-46 

2. To configure synchronization, network and startup settings, select the Synchronization tab on 

the Setting window. This page appears. 

 

     Figure 9-47 
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[Synchronization] 

 Synchronize automatically at an interval: Automatically synchronize videos from micro SD 

cards to a local folder at the specified interval. 

 Synchronize automatically at: Automatically synchronize videos from micro SD cards to a local 

folder at the specified time. 

 Download Audio Files: Download audio files along with the video files. This option is enabled 

by default. 

[Network] 

 Max. download speed of each device (Kb/sec): To make sure the bandwidth is not completely 

taken up while downloading files from the memory card, specify a maximum download speed. If 

you do not want to set a bandwidth limit, type 0. 

 

[General] 

 Start up automatically at Windows login: Automatically launch GV-SD Card Sync Utility when 

Windows starts up. 

 

3. To configure the storage and recycling settings, select the Storage tab on the Setting window. 

This page appears.  

 

                      Figure 9-48 

 

Note: By default, downloads are saved to :\GvSDCardSync and are not recycled automatically. 
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[Recycle] 

 Recycle when the storage space is less than (GB): Specify a minimum free space of your 

local storage for file recycling. 

 Keep the downloaded files for (Days): Specify the number of days to keep the download files 

at the local hard drive. 

  

[Storage Location]  

To configure the storage path, click the button next to the location field and specify a storage location. 

 

4. Click OK to save the configuration and exit the Setting window.  
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9.8.3  The Main Window 

After installing GV-SD Card Sync Utility, point to Windows Start > Programs > GV-SDCardSync > 

click  to launch the utility. This window appears. 

1

4

2

5

3

6
 

Figure 9-49 

 

No. Name Description 

1 Play Video 
Plays downloaded recordings of the selected GV-IP Cameras using the 

ViewLog player. See Chapter 4 Video Playback. 

2 Setting 
Configures settings of synchronization, network, storage location and 

recycling criteria. See Setting up the Utility earlier in this chapter. 

3 Sync all devices 
Manually synchronizes and downloads the recording files saved in 

GV-IP Camera. 

4 IP Camera Tab Shows information of GV-IP Camera connected to GV-VMS. 

5 Log Tab 
Displays up to 100 event entries. Once the entries are full, recycling will 

start from the oldest files. 

6 Storage Space Shows the storage space of the designated hard drive. 

 

Note:  

1. The synchronization time is recorded according to the system time of GV-IP Camera. 

2. The logs are deleted once the Utility is re-activated. 
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9.9  Media Man Tools 

The Media Man Tools program provides a hot-swap feature, allowing a non-stop recording. You can 

add and remove a hot-swap or portable hard drive to the GV-VMS system without interrupting its 

monitoring. When the new drive is added, it will be configured to the recording path automatically. 

  

Additionally, you can back up the ViewLog player and database files to play back at any computer.  

 

Note: The minimum disk capacity for the hot-swap feature is 32 GB.  

 

9.9.1  The Media Man Tools Window 

This program comes with the installation of GV-VMS. Locate the GV-VMS folder, and select Media 

Man Tools. This window will appear. 

       

Figure 9-50   

 
 

No.  Name Description 

1 Exit Closes or minimizes the Media Man Tools window.  

2 View  Refreshes the disk drive status shown in this window.  

3 Tools  
Sets up the LED panel and automatically logs in the Media Man Tools 

window.   

4 Display Details  
Select the option to view the status and information of the disk drives. See 

Viewing Disk Drive Status later in this section.   
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9.9.2  Viewing Disk Drive Status 

To view the detailed information of a drive, check Display Details (No. 4, Figure 9-49) in the desired 

drive section. The status window will appear.  

 

Figure 9-51 

 

No.  Name Description 

1 Disk Properties 

Indicates disk information.  

In “Media Type,” two messages may appear: 

 LAN: indicates a network hard drive is connected.   

 Local: indicates a local hard drive is connected.  

In “Status”, three messages may appear:  

 Standby: indicates the hard drive already specified as the 

recording path. 

 Unused: indicates the hard drive not specified as the recording 

path. 

 Recording: indicates the files are being recorded to the disk. 
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No.  Name Description 

2 VMS Event Info 
Indicates the path, size and number of recorded events; the dates of the 

oldest and latest events. 

3 VMS Database Info Indicates the path, size and number of the ViewLog Event List log files.  

4 MDB Info Indicates the path, size and number of System Log files. 

5 Object Index Info Indicates the path, size and number of Object Index files. 

6 ViewLog Info Indicates the location you have backed up the EZ ViewLog player. 

 

Note: The VMS Event Info updates every minute. The MDB Info, VMS Database Info, Object Index 

Info and ViewLog Info update as data changes.  
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9.9.3  Adding a Disk Drive  

1. Locate the GV-VMS folder, and select Media Man Tools.   

2. Insert a hot-swap hard drive or plug a portable hard drive to your computer. This dialog box 

appears.  

 

 Figure 9-52 
 

3. Select Add to recording path and select the storage group from the drop-down list.  

4. If there are recording files saved on the hard drive, you may select the options of Delete all 

events, Delete all database files or Delete all object index files. 

5. Click OK to automatically configure the hard drive to the recording path.  

To verify the hard drive is added successfully, check if the “Status” of the drive displays Standby 

(see Figure 9-50). 

 

Tip: To add a local drive to the recording path, right-click the desired drive on the Media Man Tools 

window (Figure 9-50) and select Add for recording. 
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9.9.4  Removing a Disk Drive 

To remove a disk drive from the recording path, right-click the desired drive on the Media Man Tools 

window (Figure 9-49), and select Remove from recording path. This dialog box will appear. You can 

export related database files with the recordings on the hard drive. You can also export the ViewLog 

player which allows you to play back the recordings on any computer.  

 

 

Figure 9-53 

 

 Export ViewLog Player:  

 Export ViewLog with database files: Exports the ViewLog player together with ViewLog 

Event List log files (.db files), related to the recordings on the hard drive.  

 Export database files only: Exports ViewLog Event List log files (.db files) only if the 

ViewLog program already exits on the hard drive.  

 Export System Log database files: Exports the System Log files (.mdb files), related to the 

recordings on the hard drive.  

 Export Object Index files: Exports the Object Index files, related to the recordings on the hard 

drive. 

 […] button: If you want to change the default folder “Viewlog” created on the hard drive, click the 

button. 

 

Note: Removing the hard drive will affect ViewLog database. To restore these events, add the hard 

drive back to the system and run Repair Database Utility. 
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9.9.5  Logging in Automatically at Startup 

To automatically log in and minimize the Media Man Tools window at Windows startup, follow these 

steps:  

 

1. Click Tools on the menu bar, and select Auto login at Windows startup. A dialog box appears.  

2. Type the ID and password of GV-VMS for automatic login in the future.  

3. If you want to minimize the Media Man Tools window to the system tray at startup, select Auto 

minimize at startup.  

4. Click OK. 

 

9.9.6  Setting up LED Panel 

A LED panel on the screen provides a quick indication of the activity status of hard disk drives.  

 

   Figure 9-54  

LED Color  Description  

Gray  No HDD is assigned to this LED.  

Green  A HDD is assigned to this LED.  

Red  The HDD is full.  

Flashing Green  
GV-VMS is recording or the video / audio files are played back in 

ViewLog.  

Flashing Red  The HDD is recycling.  
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1. Click Tools on the menu bar on the Media Man Tools window, and select Setup LED Panel. This 

dialog box appears. 

 

Figure 9-55 

 LED Panel always stays on top: Makes the LED panel stay on top of other windows when 

the Media Man Tools window is minimized.  

 Synchronize the LED Panel with the LED Device on GV-Hot Swap VMS: For GV-Hot 

Swap VMS System only. If enabled, the LED device installed on the front panel of GV-Hot 

Swap VMS System will synchronize with the LED panel on the screen.  

 Enable disk full beep: When the hard disk drive is full, the system makes the beeping 

sound. Note this function only works when the motherboard is equipped or installed with a 

PC speaker.  

2. By default, only the hard disk drive that stores video and audio files will be assigned to LED. If you 

want to re-assign the hard disk drive or assign other drives to LEDs, freely move the hard disk 

drive to the desired LED on the tree.  

3. Click OK to apply the settings, and minimize the Media Man Tools window to display the LED 

panel on the screen. 
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4. If you want to return to the Media Man Tools window, right-click the LED panel and select Switch 

to the setup window.  

 

Note:  

1. Because the LEDs are designed to indicate the video and audio files are being written or read, it 

is not recommended to assign the HDDs that store log files to the LEDs.  

2. If the HDD that stores log files is assigned to a LED, make sure the log files are not being 

written (the LED turns red) before you remove it. Otherwise, the log files might be lost during the 

removal. The default location for data storage is D:\Record\<camxx or audxx folder> for 

recorded files, D:\CameraDBs\ for event database files, and C:\GV-VMS\Database for system 

logs.  
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9.10  Alert Notifications through SNMP Protocol 

You can send alert notifications to SNMP-compatible software by using the SNMP Trap Notification 

utility. 

 

1. Click Windows Start > All Programs > GV-VMS > SNMPTrapNotification.exe. This dialog box 

appears.  

 

      Figure 9-56  

2. Type the IP address of the software that will be receiving the alert notification, and modify the 

Port if needed. 

3. To run SNMP Trap Notification upon system startup, select Auto Run at Startup.  

4. Select Send SNMP Trap to enable the function.  

5. Under Option, select the types of notifications you want to send to the software.  

6. Click Apply.
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9.11  Local and Remote Backup 
GV-VMS can back up recorded files to any connected hard disk drives or GV-Backup Center over the 

Internet. A copy of recorded files will automatically be backed up to the assigned path or GV-Backup 

Center. 

 

Note: You can only choose either Local Backup or Remote Backup (with GV-Backup Center). The 

two  backup methods can not be applied at the same time. 

 

9.11.1  Remote Backup 

To back up with GV-Backup Center, see 3.3 Connecting GV-DVR / DVR / VMS in GV-Backup Center 

User’s Manual. 

 

9.11.2  Local Backup 

To connect to a hard disk drive, follow the steps below: 

 

1. Click Home  > Toolbar  > Network  < Backup Center. The Backup Server dialog 

box appears. 

 

Figure 9-57   

https://s3.amazonaws.com/geovision_downloads/Manual/Backup-Center/GV-Backup_Center_User_Manual.pdf�
https://s3.amazonaws.com/geovision_downloads/Manual/Backup-Center/GV-Backup_Center_User_Manual.pdf�
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2. Select Local Backup in the left pane. 

3. Specify in which hard drive you want to back up your files. If you assign multiple hard drives, 

when the first hard drive is full, the files will be backed up to the second hard drive. 

4. For Advanced Settings, see the later section for details. 

5. To configure file backup schedule and transfer time, see File Transfer Setting for Local Backup 

later in the chapter. 

6. Select your desired storage path and select Connect to back up files. 

7. On the Windows taskbar, right-click on the Geo Backup Client icon. Three options are available: 

 

Figure 9-58 

 Status: “Connected” indicates that Local Backup is successfully activated. 

 Backup Status: indicates the status of file backup. 

 Playback: open the ViewLog player for playback. 

 

Figure 9-59 

 

Note:  

1. You can also click  on the first setting page of Local Backup to open the ViewLog player. 

2. Be sure to assign different Local Backup storage paths from those of GV-VMS. 
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9.11.3  Advanced Settings 

9.11.3.1  Advanced Settings for Local Backup                        

   

                                  Figure 9-60                            

 Minimum Recycle Threshold: Specify a minimum free space of your local storage for file 

recycling. 

 Keep Days: Specify the number of days to keep the download files at the local hard drive. 

 Compact Video Files Before Backup: Compact the recorded video files before backing up. 

 If the recorded video is compressed with H.265 or H.264 codec, it will be compacted into key 

frames only. 

 If the recorded video is compressed with MJPEG codec, you can use the Reserved Frames 

(MJPEG) option to specify the number of frames. 

 Limit Bandwidth xx KB/Sec: Specify a bandwidth limit when uploading files. 

 Back up except the latest xx Day(s): Specify to exclude the latest number of days during 

backup. 

 Copy Viewlog to backup drives: Copy the ViewLog player to the assigned backup drives. 

 Delete these source files after the backup is complete: Delete the recorded files in GV-VMS 

after the files are successfully backed up.  



 
Useful Utilities 

 
 

 
341

9 

9.11.3.2  File Transfer Settings for Local Backup 

The File Transfer Setting allows you to specify the recordings to back up and transfer time. 

 

In this setting dialog box, you can define the following backup rules: 

 The day of recordings to be transferred. 

 The time period of recordings to be transferred. 

 The type of recordings to be transferred, including motion detection, I/O trigger or all types of 

events. 

 The time to back up the files. 

 

Figure 9-61 

 

[Working Days] Define up to 10 backup rules to specify which recordings, including which type, which 

time period and on which working days they were recorded to be transferred to the assigned hard disk 

drive. 

1. Select the day, including Monday to Sunday. 

2. Click the arrow button before Time Span and select Modify.  

 

Figure 9-62 
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3. In this dialog box, select the Camera that you want to back up its recordings, specify Time Span 

in which time period of recordings to be transferred, and select Events that you want to back up 

all event files, Motion or I/O trigger events only.  

 

Figure 9-63 

4. Click OK. The backup settings are created. 

5. To define another backup rule, click the  button. A new Time Span is created. 

 

Figure 9-64 

6. Click the arrow button, select Modify and follow the step 3 to define the backup rule. 

 

[Holidays] Define up to 10 backup rules for non-working days, which include which non-working day, 

which camera and which type of recording to be transferred to the assigned hard disk drive. For how to 

set up a rule, see the instructions in the above [Working Days]. 

 

[Transfer Time] Define the daily time, from 00:00 to 23:59:59, to back up the files from the hosts to the 

assigned hard disk drive. 
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9.12  Report Generator 
Only available on GV-VMS V18.1 or later, Report Generator is a useful utility that allows users to 

generate daily and/or weekly reports, in MDB or HTML format, for the recording data of GV-VMS 

without requiring additional installation. 

 

For details, see Report Generator User’s Guide. 

 

 

 

9.13  GV-Cloud Center 
You can search events of GV-VMS with the cloud-based service, GV-Cloud Center. Using myGVcloud 

NotifyApp, you can receive notifications, look up events, access live view and play back recordings 

from any iOS or Android mobile devices. Without installing any software, you can also log onto 

GV-Cloud Center Portal from a Web browser on any PC to access GV-Cloud Center for event search 

and playback. For details, see GV-Cloud Center User’s Manual. 

 

Figure 9-65 

 

 

 

 

https://s3.amazonaws.com/geovision_downloads/Manual/VMS/Report-Generator_UserGuide.pdf�
https://s3.amazonaws.com/geovision_downloads/Manual/Cloud-Center/GV-CloudCenter_UserManual.pdf�
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Point-Of-Sale (POS) Application 

A POS device can be integrated to GV-VMS with transaction data overlaid on video channels. 

Transaction alerts can be triggered to notify you of transaction events. Video searches can be 

performed based on a specific transaction item or a specified time period. 

 

GeoVision provides three POS integration solutions to meet a variety of needs.  

1. Direct POS Integration 

2. GV-Data Capture Box Integration 

3. Graphic Mode POS Integration 

 

Please check the flowchart to find out which solution is suitable for you.  

 

 

  CHAPTER                        
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http://classic.geovision.com.tw/english/faq/POSflowchart/posflow-1_new.htm�
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10.1  Displaying Transactions on the Screen 

You can display transaction data on any of screen divisions without displaying live view.  

1. On the Content List, under POS, click  to set up a POS device. The POS device appears in 

the list. For details on setting up a POS device, check the flowchart. 

2. Drag and drop the created POS device to any of screen divisions. Once the transaction on the 

POS starts, the data will be displayed on the screen.    

 

            Figure 10-1 

          

http://classic.geovision.com.tw/english/faq/POSflowchart/posflow-1_new.htm�
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10.2  Setting up Text Overlay 

To change the text font and position of the transaction data on live view and recorded files, click the 

Text Setup button on the POS Server Setup dialog box (Home > Toolbar > Configure > System 

Configure > Accessories > POS Device Setup > select a POS device on the list > click the Modify 

button). 

 

                      Figure 10-2 

[Text] 

◼ Print on video file: Displays POS data on recorded videos.  

◼ Print on screen: Displays POS data on transaction scenes. 

◼ Alignment: Select the position of text overlay on the screen.  

[Clean Time] 

◼ Clean time: Specify the amount of time in seconds after which GV-VMS has not received the 

transaction data from the POS device, i.e. the cashier stops entering the transaction data. The 

already-displayed POS data will be hidden from live view. 

◼ Transaction end dwell time: Specify the amount of time in seconds that POS data stays on 

the live view before the next transaction.  

  [Set Font] Click the button to set up the font for POS data.  



 
 
 

 
348 

10.3  Filtering Transactions for a Product item 

POS Field Filter allows you to create an independent column for a transaction item in the System Log. 

The feature filters the transactions, and highlights the price of the item under the created column.  

 

For this example, the transaction item is “Golden Pineapple” which transaction data stands out in the 

System Log to attract your attention. 

 
Figure 10-3 

 

 
To set up the function, follow the steps below: 
1. On the POS Server Setup dialog box, select a POS device, and select Capture Data Setting. The 

POS Capture Data Setting dialog box appears. 

 
 

 

Figure 10-4 
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2. Select a POS device from the drop-down list for setup. 

3. Click the New button and select Caption Data. This dialog box appears. 

 

Figure 10-5 

 

[Key Word] Type a keyword matching exactly a transaction item in the receipt. The field is case 

sensitive.  

[Capture Data Type] Select the type of data followed by the specific transaction item: Numeric, 

Currency or Text. If the transaction item is followed by a price amount, select Numeric or 

Currency. If it is followed by alphabets, select Text. Any defined amount or text after the keyword 

will be brought out. 

◼ With Comma: If there are commas in a price amount, e.g. $1,000, select the option. 

◼ With Decimal Sign: If there are decimal signs in a price amount, e.g. $10.5, select the option. 

◼ With Space: The option is only available when you select Text. If there is space among 

letters, select the option. 

[MDB File Entry Name] Name the file to store the data. 

4. Click OK. 

5. Open the POS Table (Home > Toolbar > Tools > System Log > POS Table) to see the filtering 

results. 
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10.4  Triggering Transaction Alarms 

When the abnormal transaction amount of an item occurs, this function can automatically activate the 

output device and send out E-Mail alerts. To set up this function, follow these steps: 

 

1. Follow the steps in Filtering Transactions for a Product Item earlier in this chapter to define a 

transaction item first. Note that for this alarm function, a space between letters for the Keyword is 

not allowed. 

2. Click the Loss Prevention Setting button. This dialog box appears. 

       
                            Figure 10-6 

 

[Alarm Conditions] Define the price range for an alarm condition. For this example, when the 

price amount in a transaction is great than (>) than 2 dollars, the assigned alarm output and e-mail 

alert will be activated.  

[Advanced button] See Step 3 below to define the alarm frequency. 

[Alarm Output] Assign an installed output module. When the defined alarm condition is met, the 

output alarm will be triggered. 

[Alert Message] Type an alert message (the space between letters is not allowed). When the 

defined alarm condition is met, the e-mail alert will be sent. To enable e-mail notifications, see 

Setting up E-mail Notifications in Chapter 1. And the alert message will also be noted in the System 

Log. 
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3. To eliminate false alarms, configure alarm frequency.  
 

 
      Figure 10-7 

 

◼ Frequency Condition: Enable to set up the number of event occurrences within a time period 

to trigger the alarm. 

 Number of Occurrences: Specify the number of event occurrences.  

 Time Frame: Select one of the time periods: one hour, 12 hours, one day, one week or 

one month.  
 
4. Open the POS Table (Home > Toolbar > Tools > System Log > POS Table). The transactions 

met the defined alarm conditions will be marked with “unusual transaction” event in the System 

Log. 

                           

                                       Figure 10-8 
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10.5  Mapping Codepage 

This feature is to support the display of special characters and symbols. When transaction text 

incorrectly appears on the screen, a wrong character code may be used. To change a character code, 

follow the steps below. 

 

Note: When you cannot find a proper “Script” in the Set Font option (Figure 10-1), you may use the 

Codepage feature to fix the display issue of transaction text. 

 

1. In the Device dialog box, select Use Codepage Mapping and select a character code from the 

drop-down list.  

 

Figure 10-9 

 
2. To verify the character code you selected, click the […] button to preview its codepage. 

 
 

                            Figure 10-10   
 
3. In the From field, select one symbol or character that are not displayed correctly. In this example, 

you can see its previous character code (From side: Ox9C) has been transferred to the default 

equivalent (To side: OxA3).  
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10.6  Coloring Transactions of a Product Item 

You can highlight a desired transaction item in any color. When the transaction item is identified, its text 

will have an outstanding color than others on the live view, and the alarm and e-mail alerts can be 

triggered at the same time. For example, if the liquor is prohibited for sale in the midnight, a seller can 

use this feature to prevent from any unintentional sale.  

 

The identification will be recorded in the System Log for later retrieval as well. In this example, the 

transaction item “Strawberry” is colored red, “Golden Pineapple” is orange, and “Ice Cream” is pink 

whenever these transaction items appear. 

  

Figure 10-11 
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To configure the coloring feature, follow the steps below: 

1. On the POS Server Setup dialog box, select Capture Data Setting. The POS Capture Data 

Setting dialog box appears. 

 
 

 
Figure 10-12 

2. Click New and select Color Keyword. This dialog box appears.  

 
   Figure 10-13 

 

[Key Word] Type the keyword to be identified in the transactions. The field is case sensitive.  

[Color] Select a color to show on the keyword.  

[Only work between] Specify the time period of transactions to identify the keyword. 
 
Note: You can set up to 32 keywords for identification.  
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3. To trigger an alarm when the keyword is detected during the transactions, click the Loss 

Prevention Setting button. This dialog box appears.  

 
                 Figure 10-14 

 

◼ Alarm Conditions: Enable the alarm when the defined text is detected. To configure alarm 

frequency, click the Advanced button. For details, see Step 3, Triggering Transaction Alarms 

earlier in this chapter. 

◼ Alarm Output: Assign an installed output module. When the defined alarm condition is met, 

the output alarm will be triggered.  

◼ Alert Message: Type an alert message. When the defined alarm condition is met, the e-mail 

alert will be sent. To enable e-mail notifications, see Setting up E-mail Notifications in Chapter 1.  

4. Click OK.  

 

When the keyword is identified in the transactions, the identification appears not only on the live view, 

but also are recorded in the System Log (ViewLog > Toolbar > Tools > System Log > POS Table).  
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10.7  Displaying Receipt Details of a 

Transaction 

You can find out receipt details of a single transaction, so you will know the amount of the transaction, 

as well as the total number and total amount of all transactions during a defined period of time. 

All the transaction contents related to the 

single transaction

Number of transactions during 

the defined period of time

Amount of the single 

transaction

Total amount of transactions 

during the defined period of time

A single transaction

Figure 10-15  

 

To have the feature, you need to define the format of how the amount of a transaction is shown and 

how a transaction ends on the receipt. Follow the 3 steps below to complete the settings: 

⚫ Step 1: Defining the Amount of a Transaction Shown on the Receipt 

⚫ Step 2: Define How a Transaction Ends on the Receipt  

⚫ Step 3: Displaying Receipt Details of a Transaction 
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Step1: Defining the Amount of a Transaction Shown on the Receipt 

1. On the POS Server Setup dialog box, select a desired POS device, and select Capture Data 

Setting. The POS Capture Data Setting dialog box appears. 

2. Click the New button. This dialog box appears. 

 

Figure 10-16 

3. Take the following receipt as an example. 

 

Figure 10-17 
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a. Type the keyword related to the amount of a transaction. In this example, the keyword is 

“Total” which is a prefix in the amount and appears in every receipt. Note the field is case 

sensitive. 

b. Under Capture Data Type, define if the total amount is attached with a currency symbol. In 

this example, select Currency because the currency symbol $ is used. 

c. Select With Comma if there are commas in the total amount. Select With Decimal Sign if 

there are decimal signs in the total amount. In this example of “Total $12.35”, select With 

Decimal Sign.  

4. Select Transaction Amount, and click OK. 

 

Step 2: Defining How a Transaction Ends on the Receipt 

5. On the POS Server Setup dialog box, select the specific POS device, and select Filter Setting. 

The Filter Setting dialog box appears. 

 

 

Figure 10-18 
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6. Click the New button. This dialog box appears. 

 

Figure 10-19 

a. Under Select Sample, select the type of printer attached to the POS device, or the 

GeoVision program installed in the POS device. 

b. Under Filter Name, name the filtering criteria. In this example, we will define how a 

transaction ends on a receipt, so naming it as “End of Transaction”. 

7. Click the Add button. The Filter Name appears in the list. 

8. Select the created filter name and click the Modify button. This dialog box appears. 

 

Figure 10-20 
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9. Click the New button. This dialog box appears. 

   

Figure 10-21 

10. Type the keyword indicating the end of a transaction, and add comma (,) between every letter. In 

this example, the keyword is “Change” which appears at the end of every transaction, so type 

C,h,a,n,g.e.  

 

Figure 10-22 

11. Under Action, select Stop Transaction. 

12. Click OK several times to return to the POS Server Setup dialog box. 
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13. Select the POS device in the list applied for the filter setting, and click the Modify button. The 

Device dialog box appears. 

14. Under Filter Setting, select the filter setting you set up for the end of a transaction. In this example, 

its “End of Transaction”.  

 

Figure 10-23 

15. Click OK. 

 

Step 3: Displaying Receipt Details of a Transaction 

16. Select ViewLog  > Toolbar  > Tools  > System Log > Advanced. The Open 

Database dialog box appears. 

17. Define a period of time to retreive the POS data. 

18. From the left side of toolbar, select POS data, select which POS device, and click  to have a 

list of transactions during the defined period of time. 

Figure 10-24 

19. When you click a transaction on the List, its related receipt content will be displayed. 
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10.8  Filtering Transactions by a Keyword 

You can filter transactions by a keyword to have the following functions: to start a new line after the 

keyword, to remove unwanted text before the keyword, to replace a keyword with another, and/or to be 

noted as Event, such as Cash Drawer Open, in the System Log when the keyword appears. 

 

For example, we define “Change” as the keyword, and specify it as “Cash Drawer Open” event. 

Whenever “Change” appears on the receipt, in the System Log, you will see not only the details of the 

transaction, but also an event “Cash Drawer Open” recorded. 

 

Figure 10-25 
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To configure the function, follow the steps below: 

1. To open the following dialog box, follow Step 5 to 8 in Step 2: Defining How a Transaction Ends 

on the Receipt, 10.6 Displaying Receipt Details of a Transaction.  

   

        Figure 10-26 

2. Type the keyword and add comma (,) between every letter. In this example, the keyword is 

“Change”, so type C,h,a,n,g.e.  

3. If the keyword has a random prefix, select Use Random Word, and type the symbol (*) before 

the keyword, e.g. *,C,h,a,n,g.e. 

4. If you want the text to start a new line whenever the keyword appears, select Command is 

change line. 

5. If you want to remove garbled text before the keyword, type the number of characters you want to 

remove in Cut Length. 

6. If you want to replace the keyword with another, select Use Replace and type a desired word. 

7. You can define an event to show in the System Log: Alert, Cash Drawer Open, Cash Drawer 

Close, Start Transaction, Stop Transaction, or Valid Transaction. 

8. Click OK several times to return to the POS Server Setup dialog box. 
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9. Select the POS device in the list applied for the filter setting, and click the Modify button. The 

Device dialog box appears. 

10. Under Filter Setting, select the filter setting you set up before. In this example, it is Cash Drawer 

Open. 

 

Figure 10-27 

11. Click OK. 

12. Open the System Log (ViewLog > Toolbar > Tools > System Log > POS Table) to view the 

filtering results. 
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10.9  Searching for POS Events 

Only available on GV-VMS V18.1 or later, with the POS Search function, you can instantly search for 

and play back POS events from the ViewLog. To access this function, click ViewLog  > Toolbar  

> Tools  > POS Search. This window appears. 

 

1

3

8

7

4

2

5 6

9

                                      Figure 10-28 

No. Name Description 

1 Playback Window 
Displays the recording of the POS event or content selected. Right-click 
on the window to have the options of Play Mode, Render and Tools 

2 Transaction Window 
Displays all POS transactions viewed while playing back on the Playback 
Window. 

3 Exit Click to close Quick Search screen 

4 Playback Panel 
Includes Play, Pause, Previous 10 frames, Next 10 frames and End 
buttons, as well as Time Period buttons to jump to 1 second, 10 seconds, 
1 minute, 10 minutes and/or 1 hour later or earlier.  
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5 
Expand / 
Shrink Dialog 

Select Expand/Shrink Dialog to display the Transaction window or 
select Advanced Search to display the Advanced Search panel. 

6 Find Condition 

Click Find Condition  to search for specific keywords and/or a type of 
POS transaction event forward or backward, starting from a date and 
time set. Use the Find Previous  and Find Next  buttons to jump 
from one search result to another. 

7 
Advanced Search 
Panel 

See 6.1.1 Advanced Search Settings later. 

8 Search Results Displays the search results by Advanced Search. 

9 320<->640 Click to switch between 640 x 480 and 320 x 240 display.  

 

 

Advanced Search Panel 

To search for POS events with detailed criteria, click Expand / Shrink Dialog  on the POS Search 
windo and select Advanced Search. The Advanced Search Panel appears. 

 

1. Select the Start / End Dates and Start / End Times from the respective drop-down lists to 

specify the desired time period of your POS search. 

2. Select the POS devices you want to search for in the POS Device drop-down list. 

3. Optionally select POS Event to search for a type POS transaction event. 

4. Optionally select Find Text to type a keyword you want to search for. 

5. After the desired conditions are set, click Search . The search results will be displayed at the 
left of the panel. 




